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Introduction to Steel Connections

• Levels & Grids
• 3 Column Types

Wide Flange
Round
Square

• Beams

• 22 X 34 Sheet
• Coordinated Views
& Isometrics
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Introduction to Steel Connections Assignment
Creating 3D families build the 3D Revit
model described in the assignment.

These 3d Families will be assembled in a
project file named as follows:

FirstLastName-Connections-AR2431-SP20-Professor.rvt

As specified create families using
modifiable parameters.

Format the assembly on a 22 x 34”
titleblock. As before be certain your
photo and name is on each sheet.

Create additional sets of coordinated
views of assembly connections at
enlarged scale along with an isometric.

Add annotation (notes and leaders)
dimensions and detail items as
necessary to clarify the details.

Review class readings and conduct
additional research as needed to
complete the assignment.

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Introduction to Steel Connections Assignment
Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Introduction to Steel Connections Assignment

Reference sheet of  standard 
dimensions for 
Wide Flange Sections

• Depth (h)
• Width (w)
• Web thickness (tw)
• Flange Thickness (tf)
• Sectional Area (sq inches)
• Weight (lbs. per linear foot)

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Creating a New Project File
• Create a new Project File

 Architectural Template or
Imperial-Architectural Template

• Save and Name the File
 Create a working directory for all

your project and family files –
stay organized!

• Select an appropriate directory
 (do not work from your USB!

This will cause all backup files to be
saved there and fill up your drive and
potentially crash the program.)

• Name the file as follows:
 FirstLastname-Connections-

AR2431.SP20-ProfessorName.rvt

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Modify Level 2 elevation from 10 to 12 feet

• Project Browser
 Select the East Elevation

• Select Level 2
 Highlight the Elevation [10’-0”]

 Change the Elevation to [12’-0”]

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Add Level 3

• Architecture Ribbon
 Activate East view then select Level
 Method = Pick Lines

• Set Offset to 12’-0” & [Yes] Make Plan View
 Move cursor just above Level 2
 Select and Level 3 will be created

• Select the Modify Button to end command

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Add Column Grids on Level 1

• Set Level 1 as the current view
 Architecture Ribbon > Grid

• Draw Vertical Grid 1 from top to bottom
• Draw Vertical Grid 2 from top to bottom

 Modify Spacing to 25 feet
• Draw Horizontal Grid (will be numbered 3)

 Change Name from 3 to A

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Add Column Grids on Level 1

• Draw Grid Line B
 Set Spacing to 15’-0”

• Shorten the Grid Lines
• Move & Center the Grid
 Select Grid & Drag

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Add Dimensions

• Annotate Ribbon
 Aligned Dimension

• Add vertical dimension
• Add Horizontal Dimension

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Creating a new 3D Family File
• We will repeat this for each component

of the Steel Connection Assembly

• Create a new Family
 File > New > Family 

(English Imperial)
 Generic Model Template

• Save and Name the File

• Select an appropriate directory

• Name the file as follows:
 Initials- Description
 PK – Steel W 24 x 162

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet



Building 
Technology III

CityTech.CUNY.edu

Wide Flange W 24 x 162
• W 24 x 162

 Depth (h) = 25”
 Width (w) = 13”
 Web Thickness = .705”
 Flange Thickness = 1.220”

Source of Information: 
https://www.engineeringtoolbox.com/american-
wide-flange-steel-beams-d_1319.html

Additional Reference for steel components: 
http://products.anssteel.com/category/steel?

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet

https://www.engineeringtoolbox.com/american-wide-flange-steel-beams-d_1319.html
http://products.anssteel.com/category/steel
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Family Ribbons and Project Browser Views
• W 24 x 162

 Depth (h) = 25”
 Width (w) = 15”
 Web Thickness = .705”
 Flange Thickness = 1.220”

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Add Reference Planes for the Depth & Width

• Create Ribbon
 Reference Plane

• Depth pick lines 
Offset (25/2 = 12.5”)
 Add two

• Width pick lines
Offset (13/2 = 6.5 “)
 Add two

• W 24 x 162
• Depth (h) = 25”
• Width (w) = 13”

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet



Building 
Technology III

CityTech.CUNY.edu

Add Dimensions & define adjustable Parameters

• Annotate > Aligned   (Add two dimensions then EQ)   Then Overall & Repeat

• W 24 x 162
• Depth (h) = 25”
• Width (w) = 15”

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet



Building 
Technology III

CityTech.CUNY.edu

Add Dimensions & define adjustable Parameters

• Select Depth (2’-1”) > Create Parameter
 Type = Family
 Name = Depth
 Instance

• Select Width (1’-1”) > Create Parameter
 Type = Family
 Name = Width
 Instance

• W 24 x 162
• Depth (h) = 25”
• Width (w) = 15”

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Add Reference Planes for Web & Flange

• Create Ribbon
> Reference Plane

• Flange pick lines 
Offset (1.22”)
 Add both top 

and bottom

• Web pick lines Offset 
(.705/2 = .3525”) 
 Add two left and 

right

• W 24 x 162
 Web Thickness = 

.705”
 Flange Thickness = 

1.220”

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Create the Extrusion
• Create Ribbon > Extrusion (Solid)
 Lines (trace the shape using reference planes)
 Green Check (Save and end Sketch Mode)
 Default 3D View
 Remember to lock lines to reference planes

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Add Reference Plane for Height & Lock Top & Bottom

• Left View> Create > Reference Plane
• Pick Lines (offset 5’-0”)

• Drag top to reference plane and lock it
• Drag bottom up then back don and lock it

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Add Dimension and Parameter for Height

• Select Dimension
• Create Parameter
 Type = Family
 Name = Height
 Instance

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Using Parameters to Control the 3D extrusion
• Properties > Family Type

 Notice the list of  parameters

• Change Height from 5’ to 12’
 Notice the 3D model updates

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Set Family Category to Structural Connections

• Family 
Category & 
Parameters

• Select 
Structural 
Connections

• Save the file

• Load into 
Project

• Snap to 
Column 
Grids B & 1

• Save your family (your working directory)
• Be good about appropriate names for family files
• Load into Project 

 (family file remains open)
• Load into Project and Close 

 (family file will close)
• The family is saved inside the project file

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet



Building 
Technology III

CityTech.CUNY.edu

Look under Family Category for Structural Connections

• In the project browser the family will show in the category “Structural Connections”

• To create additional copies either copy the one already in the project or drag it from
the project browser into the project

• Modify the height of  the first column to 15’-0” (12’ for the Level + an extra 3 feet)

• Make a copy 15 feet above the first column

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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HSS High Strength Steel Pipe Columns

Source of Information: https://www.engineeringtoolbox.com/american-wide-flange-steel-beams-d_1319.html
Additional Reference for steel components: http://products.anssteel.com/category/steel?

• For Round Column HSS 10  Outside Diameter 10” Thickness = .5”

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet

https://www.engineeringtoolbox.com/american-wide-flange-steel-beams-d_1319.html
http://products.anssteel.com/category/steel
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HSS High Strength Steel Pipe Columns (Create)
• For Round Column HSS 10  Outside Diameter 10” Thickness = .5”

• New > Family > Generic Model Save_as Initials-HSS-Round 10 x .5
• Create > Extrusion > Circle (radius 5”) > Pick Lines (.5”)

Set Family 
Category to 
Structural 
Connections

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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HSS High Strength Steel Pipe Columns (Parameters)

• Edit Extrusion > Annotate > Diameter
• Add Parameter (Outside Diameter)
• Family Type > New Parameter (Inside Diameter)

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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Add Formula to Parameter

• Inner circle is dependent on outer
• = Outside Diameter - .5”
• Annotate > Diameter (inner circle)
• Assign Parameter to Inner Circle

Diameter
• Add additional 

reference plane 
and parameter to 
control the height

• Save and Load 
into Project file

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet



Building 
Technology III

CityTech.CUNY.edu

HSS Square Hollow Structural Sections

Source of Information: https://www.engineeringtoolbox.com/american-wide-flange-steel-beams-d_1319.html

Additional Reference for steel components: http://products.anssteel.com/category/steel?

• For Square Column 10 x 10 x .5 Outside Dimension 10” x 10” Thickness 0.5”

Steel Connections 

Introduction

• Assignment 

Description

• New Project File
 Levels

Grids

Dimensions

• New 3D Family

• W 24 x 162 column
Reference Planes

Parameters

Extrusion

Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet

https://www.engineeringtoolbox.com/american-wide-flange-steel-beams-d_1319.html
http://products.anssteel.com/category/steel
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HSS Square Hollow Structural Columns (Create)
• For Square Column 10 x 10 x .5 Outside Dimension 10” x 10” Thickness 0.5”

• New > Family > Generic Model     Save_as Initials-HSS-Square 10 x10x.5
• Create > Extrusion > Rectangle (10x10”)   >Rectangle Offset .5”

• Draw & Lock to 
Reference 
Planes

• Add aligned 
dimension for 
inner rectangle
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Height Parameters

 Family Category

• Load into Project

• New 3D Families
HSS Pipe Column

 Formula Parameter

HSS Square Column

W 21 x 162 Beam

Place Beam

Snap, Align & Copy

Modify Round Column 

Family

• Project File Sheet
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HSS Square Hollow Structural Columns (Parameters)
• For Square Column 10 x 10 x .5 Outside Dimension 10” x 10” Thickness 0.5”

• Select one of  the 10” dimensions > Create Parameter (Width, Instance)
• Select the second 10” dimension > assign the same parameter

• Add additional reference plane and 
parameter to control the height

• Set Height to 12’
• Save and Load into Project file

Set Family 
Category to 
Structural 
Connections
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Create the W 21 x 62 Beam (use front view)

Source of Information: https://www.engineeringtoolbox.com/american-wide-flange-steel-beams-d_1319.html

Additional Reference for steel components: http://products.anssteel.com/category/steel?

• For Beam W 21 x 62 Depth = 21” Width = 8.24” Web = 0.4” Flange = .615”

• For Column W 24 x 162 Depth = 25” Width = 13” Web = 0.4” Flange = 1.22”
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Create the Beams (use front view)
• For Beam W 21 x 62 Depth = 21” Width = 8.24” Web = 0.4” Flange = .615”

• New > Family > Generic Model Save_as Initials-Steel Beam W 21x62
• Draw from front view – align top of beam with ref. level
• Add Reference Plans same as for W 24 x 162 column – add extra plane at center of beam
• Create > Extrusion > Lines
• Add reference planes, add dimension and define parameter for length
• Save and Load into Project File
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To Place the Beams & Add Structural Plan Views

• Review the project browser
• The families we created are located under “structural connections”
• A structural plan only exists for Level 3, the new level we added to the project file

• Add the missing structural views as follows:
• View Ribbon > Plan Views > Structural Plan
• Select Level 1 & Level 2 > OK
• The new structural levels will show in the project browser
• Make Level 3 Structural the current view
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Compare Floor Plans vs Structural Plans

• From the project 
browser 
compare the 
“view range” 
properties of a 
plan view vs a 
structural view

• View Range 
Floor Plan

• Bottom and 
View Depth 
Offsets are 0

• View Range 
Structural 
Plan

• Bottom 
Offset -4’0”

• View Depth 
Offset -6’-0”

• We will work from the structural views –
as they allow us to see below the 
selected level.  Remember beams are 
below the floor.
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Add the Beams to Level 3 – Grid Line 1 (A to B)

• From the project browser select the 
beam and drag it to snap onto 
Grid line 1 between Grids A & B

• Select and drag the other 
end and snap to the 
column at Grid A

• Align and snap the end 
of the beam to the 
column at Grid B
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Add the Beams to Level 3
• Set EAST as the current View
• Select the Beam on Level 3
• Copy it down to Level 2
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Add the Beams to Level 3 – Grid Line B (1 to 2)

• We will not be able to snap to the round column without 
first modifying the column family to include reference 
planes for snapping

• Align and Snap the 
end of the beam to 
the column at Grid 1
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Edit the Column Family (PK – HSS Round 10 x .5)

• Draw 4 Reference Planes snapping to quadrant points
• Extend the reference planes and add dimensions
• Assign the Outside Diameter Parameter to the two 

overall dimensions
• Load into Project

The single 
parameter 
Outside 
Diameter will 
control the 
column size & 
the distance 
between the 
reference 
planes and by 
formula the 
inside 
diameter.
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Align the end of the Beam to the Column

• Copy the Beam 
from Level 3 down 
to Level 2

• Drag or Align 
the end of 
Beam to Face 
of Column

• Lock it
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Sheet layout 22 x 34  SC-01

• ¼” Scale Views
• Plan View
• Front Elevation
• Side Elevation

• NW Isometric
• SE Isometric
• Perspective w/Shadows
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